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REF-Vacuum-C101-2ED User Guide 

SOI driver & Vacuum Application Reference Design Kits  

About this document 

Scope and purpose 

This user guide provides an overview of the reference board REF-Vacuum-C101-2ED including its main features, 
key data and mechanical dimensions. 

REF-Vacuum-C101-2ED is a full-featured starter kit, turnkey low-voltage motor drive designed for high-

performance, high-efficiency PMSM/BLDC motor drive applications, including all of the required elements for 

vacuum applications, such as IMC101T iMOTIONTM controller, 2ED2304S06F SOI half-bridge gate driver and 
BSC030N04NS OptiMOSTM.  

The starter kit features and demonstrates Infineon’s thin-film SOI technology and advanced motion control 

engine (MCE 2.0) technology for low-voltage, permanent-magnet motors drive up to 120 kRPM speed, and 
inverter section up to a rating of 30 V and 25 A.  It is optimized for major low-voltage home appliances like 
vacuums, fans, pumps, compressors and other low-voltage motor drive applications. 

Intended audience 

This application note is intended for all technical specialists who are familiar with high-speed motor control 

and low-voltage electronics converters. The reference design is intended to be used under laboratory 
conditions only by trained specialists. 

 

 
 

 

 

 
 

 

 
 

 

Ordering information  

  

Base Part Number Package Standard Pack Orderable Part Number 

Form Quantity 

REF-VACUUM-C101-2ED EVAL Boxed 1 REFVACUUMC1012EDTOBO1 

IMC101T-T038 PG-TSSOP-38-9 Tape and Reel 3000 IMC101TT038XUMA1 

BSC030N04NS G PG-TDSON-8 Tape and Reel 5000 BSC030N04NSGATMA1 

2ED2304S06F  PG-DSO-8 Tape and Reel 2500 2ED2304S06FXUMA1 



  

User Guide                 www.Infineon.com/iMotion  2 of 43 www.Infineon.com/SOI                                Revision 1.0 

  2020-5-22 

 

Table of contents 

Table of contents 

About this document ....................................................................................................................... 1 

Ordering information ...................................................................................................................... 1 

Table of contents ............................................................................................................................ 2 

Important notice ............................................................................................................................ 3 

1 Safety precautions ................................................................................................................. 5 

2 Introduction .......................................................................................................................... 6 

3 REF-Vacuum-C101-2ED main features ....................................................................................... 7 

3.1 REF- Vacuum -C101-2ED board specifications ....................................................................................... 8 

3.2 Connector pin assignment .................................................................................................................... 10 

4 Product overview of 2ED2304S06F .......................................................................................... 12 

4.1 Internal block diagram .......................................................................................................................... 13 

4.2 The detailed features and functions of 2ED2304 ................................................................................. 14 

4.3 Tolerant to negative transient voltage on VS pin (-VS) ......................................................................... 14 

5 Getting started with REF- Vacuum -C101-2ED ........................................................................... 16 

6 Hardware description of REF-Vacuum-C101-2ED ....................................................................... 22 

6.1 Inverter section ..................................................................................................................................... 22 

6.1.1 DC bus sensing and MCEWizard configuration ............................................................................... 24 

6.1.2 External op-amp configuration and calculation for current feedback .......................................... 25 

6.1.3 Configuration and calculation for direct current sensing .............................................................. 26 

6.1.4 Inverter overcurrent protection and motor gatekill configuration ................................................ 28 

6.2 NTC thermistor characteristics and overheat protection calculation ................................................ 30 

6.2.1 External NTC thermistor characteristics ......................................................................................... 31 

6.3 Auxiliary power supply .......................................................................................................................... 33 

6.4 Schematics for REF-Vacuum-C101-2ED ................................................................................................ 33 

6.5 PCB Layout for REF-Vacuum-C101-2ED ................................................................................................ 35 

7 Thermal characterization ....................................................................................................... 38 

8 Bill of material ...................................................................................................................... 39 

9 Reference ............................................................................................................................. 41 

Revision history............................................................................................................................. 41 

 
 

 

 

 

 

 

 

 

 



  

 

User Guide                 www.Infineon.com/iMotion  3 of 43 www.Infineon.com/SOI                                Revision 1.0 

  2020-5-22 

 

UG2020-11 REF-Vacuum-C101-2ED User Guide  

Important notice 

Attention: The Reference Boards as well as the information in this document are solely intended to 

support designers of applications in evaluating the use of products from Infineon 
Technologies for their intended applications. 
 
Environmental conditions have been considered in the design of the Reference Boards 

provided by Infineon Technologies. The design of the Reference Boards has been tested by 

Infineon Technologies only as described in this document. The design is not qualified in terms 
of safety requirements, manufacturing and operation over the entire operating temperature 
range or lifetime. 

 

The Reference Boards provided by Infineon Technologies are subject to functional testing 
only under typical load conditions.  Reference Boards are not subject to the same procedures 
as regular products regarding returned material analysis (RMA), process change notification 

(PCN) and product discontinuation (PD). 

 
 Reference Boards are not commercialized products, and are solely intended for evaluation 

and testing purposes. In particular, they shall not be used for reliability testing or 
production. The Reference Boards may therefore not comply with CE or similar standards 

(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not 

fulfill other requirements of the country in which they are operated by the customer. The 
customer shall ensure that all Reference Boards will be handled in a way which is compliant 

with the relevant requirements and standards of the country in which they are operated. 

 

The Reference Boards as well as the information provided in this document are addressed 

only to qualified and skilled technical staff, for laboratory usage, and shall be used and 
managed according to the terms and conditions set forth in this document and in other 
related documentation supplied with the respective Evaluation Board or Reference Board.  

 

It is the responsibility of the customer’s technical departments to evaluate the suitability of 

the Reference Boards for the intended application, and to evaluate the completeness and 
correctness of the information provided in this document with respect to such application. 
 

The customer accepts that the Reference Boards are not intended to be used in life-
endangering applications such as medical, nuclear, military, life-critical or other 
applications, where failure of the Reference Boards, or any results from the use thereof, can 

reasonably be expected to result in personal injury. 
 

The Reference Boards and any information in this document is provided "as is" and Infineon 
Technologies disclaims any warranties, express or implied, including but not limited to 

warranties of non-infringement of third party rights and implied warranties of fitness for any 
purpose, or for merchantability.  

 
Infineon Technologies shall not be responsible for any damages resulting from the use of the   
Reference Boards and/or from any information provided in this document. The customer is 
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any 
claims or damages arising out of or resulting from any use thereof. 
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Infineon Technologies reserves the right to modify this document and/or any information 
provided herein at any time without further notice. 
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1 Safety precautions 

Please note the following warnings regarding the hazards associated with development systems. 

Table 1 Safety precautions 

 

Caution:  Only personnel familiar with the drive, power electronics and associated 
machinery should plan, install, commission and subsequently service the system. Failure to 

comply may result in personal injury and/or equipment damage. 

 

Caution: The heat sink and device surfaces of the evaluation or reference board may 
become hot during testing. Hence, necessary precautions are required while handling the 

board. Failure to comply may cause injury. 

 

Caution: REF-Vacuum-C101-2ED reference board contains parts and assemblies sensitive to 
Electrostatic Discharge (ESD). Electrostatic control precautions are required when installing, 

testing, servicing or repairing the assembly. Component damage may result if ESD control 

procedures are not followed. If you are not familiar with electrostatic control procedures, refer 

to the applicable ESD protection handbooks and guidelines. 

 

Caution: A drive that is incorrectly applied or installed can lead to component damage or 

reduction in product lifetime. Wiring or application errors such as undersizing the motor, 
supplying an incorrect or inadequate DC supply, or excessive ambient temperatures may 

result in system malfunction. 

 

Caution: REF-Vacuum-C101-2ED reference board is shipped with packing materials that need 

to be removed prior to installation. Failure to remove all packing materials that are 

unnecessary for system installation may result in overheating or abnormal operating 

conditions. 
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2 Introduction 

The REF-Vacuum-C101-2ED is part of the iMOTION™ reference design kits. It is designed to provide ready-to-

use, low-voltage and high-speed vacuum solutions based on Infineon’s thin-film SOI technology and advanced 
motion control engine (MCE 2.0) technology. It allows fast prototyping and fast time to market.  The board is 

equipped with all assembly groups for sensorless field-oriented control (FOC), and reserved interface for three 
digital Hall sensors, so that it can be extended to other low-voltage and high-current motor applications. 

The block diagram of the REF-Vacuum-C101-2ED is depicted in Figure 1, which contains iMOTION™ controller 
IMC101T, 3 mOhm 40 V OptiMOSTM, and 2ED2304S06F half-bridge gate driver with integrated bootstrap diode. 

 This reference design includes: 

- Gate driver IC for MOSFET  

- Anti-reverse connection protection 

- 12 V & 3.3 V auxiliary power supply 

- VSP speed command potentiometer 

- Over temperature and overcurrent protection 

- Turnkey version sensor less & sensor FOC control 
 

M
3-phase 
inverter

Anti-reverse 
connection 
protection

Isolated USB-to-
UART Cable

2ED SOI Gate 
driver

Power 
supply

IMC101T

12V

3.3V

PWM

VDC

Analog

Single Shunt Current sensing

Host 
Communication

 

Figure 1 Block diagram of the REF-Vacuum-C101-2ED 

The REF-Vacuum-C101-2ED reference design is available through regular Infineon distribution partners as well 
as on Infineon's website. The main features of this board are described in this document, whereas the 
remaining paragraphs provide information to enable the customers to copy, modify and qualify the design for 

production according to their own specific requirements. 

 

An 18 V, 250 W vacuum motor is used for the default DEMO function, whose maximum speed is 100 kRPM. 

Please note that motor parameters need to be double-checked in MCEWizard if a different motor is used. 
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3 REF-Vacuum-C101-2ED main features 

REF-Vacuum-C101-2ED is a reference design for 24 V (like 6~7S Li battery) low-voltage motor drive applications. 

 Main features of SOI half-bridge gate driver 2ED2304S06F include: 

• Infineon thin-film SOI technology 

• Fully operational to +650 V, floating channel designed for bootstrap operation  

• Output source/sink current capability +0.36 A/-0.7 A  

• Integrated ultra-fast, low RDS(ON) bootstrap diode 

• dV/dt immune ±50 V 

• Tolerant to negative transient voltage up to -100 V 

• 10 ns typ., 60 ns max. propagation delay matching 

• Integrated minimum dead time 75 ns, shoot-through prevention 

• Gate drive supply range from 10 V to 20 V,  undervoltage lockout for both channels 

• 3.3 V, 5 V and 15 V input logic compatible 

 

Main features of iMOTION™ controller IMC101T include: 

 Motion control engine as ready-to-use controller solution for sensorless and Hall-sensor motor drives  

 Field-oriented control (FOC) for permanent magnet synchronous motor (PMSM/BLDC) 

 Optional support for Hall sensors (analog or digital)  

 Space vector PWM with sinusoidal commutation and integrated protection features 

 Current sensing via single shunt or leg shunt  

 Integrated analog comparators for overcurrent protection 

 Integrated scripting engine for application flexibility 

 3.3 V or 5.0 V supply voltage options for controller 

 Flexible host interface options for speed commands: UART, SPI, PWM or analog signal 

 Class B pre-certification (IEC60335) for MCE2.0 firmware 

 

The REF-Vacuum-C101-2ED reference design characteristics include: 

• Input voltage 18~30 V DC  (6S ~ 7S Li battery) 

• Maximum  600 W at 25 A,  24 V DC power input with on-board cooling fan 

• Anti-reverse connection protection 

• VSP speed command potentiometer  

• 3 digital Hall interface 

• User UART for script function 

• Overcurrent  and over temperature protection, fault diagnostic LED output 

• Low-noise, single-shunt current sample 

• Auxiliary power supply with 12 V, 3.3 V 

• PCB is 60 mm × 115 mm (or 60 mm × 63.5 mm if cooling fan is removed), 2 layers, 1 oz. copper  

• RoHS compliant  
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3.1 REF- Vacuum -C101-2ED board specifications 

Table 2 depicts the key specifications of the reference design REF-Vacuum-C101-2ED. 

Table 2 REF-Vacuum-C101-2ED board specifications 

Parameters Values Conditions / comments 

Input 

Voltage  18 - 30 Vrms 6S ~ 7S Li battery or 24VDC input 

Input current 25 Arms Input 24 VDC, Ta=25 C, BSC030N04NS with cooling fan 

Output 

Power (3 phases) 600 W Input 24 VDC, fPWM=22 kHz, Ta=25°C, Tmos= 105 °C 

Current per phase 22 Arms Input 24 VDC, fPWM=22 kHz, Ta=25°C, Tmos= 105 °C 

DC bus voltage 

Maximum DC bus voltage 30 V (max) MOSFET BSC030N04NS’s V(BR)DSS is  40 V 

Minimum DC bus voltage 10 V (min) Need bypass ZD2, ZD3 and U1 

2ED2304 undervoltage negative-going threshold 9 V  

Switching frequency   

Maximum inverter 
switching frequency fPWM  

80 kHz (max) IMC101T’s firmware max. time usage depends on 

enabled function blocks and control rate setup 

Minimum inverter 

switching frequency fPWM 
6 kHz *  

 

Depends on motor control performance and Wizard 

calculation (motor  poles and R & L) 

IMC101T’s firmware scaling limit is 2 kHz 

Current feedback   

Inverter current sensing 
resistor RS1 

2 mΩ Can adjust to 5~10 mΩ for lower current motor 
application (with external OPA) 

Or above 20 mΩ shunt resistor for directly ADC sample 
(without external OPA) 

Protections 

Output current trip level 80 A peak
1 Wizard setup for OC trigger level 

Related to shunt resistor RS1 and OPA’s bias 

Temperature trip level 105 °C (typ) Needs to consider the temperature gap between MOS 

and NTC sensor  

On-board power supply 

12 V 12 V ± 1 %, max. 100 mA Used for MOS gate driver and 3.3 V LDO 

3.3 V 3.3 V ± 1 %, max. 100 mA Used for IMC controller and protection circuits 

PCB characteristics 

Material FR4, 1.6 mm, 1oz  PCB 2 layers 

Dimension 60 mm × 115 mm 60 mm × 63.5 mm if cooling fan is removed 

System environment 

Ambient temperature From 0 to 50 °C Non-condensing, maximum RH of 95 % 

                                                                    
1     For iMOTION™ IC IMC1xx, there are three types of Gatekill Input Source options in MCEWizard setup.  

If select “comparator” mode, the external Gatekill signal will be not used, and the signal I_Shunt will be compared by the internal 

comparator with the “Device Overcurrent trigger level setting” value set in MCEWizard.  
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Figure 2 points out the functional groups on the top side of the REF-Vacuum-C101-2ED reference design 
 

  

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

Figure 2 Functional groups of the REF-Vacuum-C101-2ED reference design’s top side 
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Figure 3 points out the functional groups on the bottom side of the REF-Vacuum-C101-2ED reference design 
 

 
 

 

 

Figure 3 Functional groups of the bottom side of REF-Vacuum-C101-2ED reference design  

3.2 Connector pin assignment 

General information about the connectors of the REF-Vacuum-C101-2ED reference design is reported in this 
section. Table 3 includes the details of the DC input connector. 

Table 3  DC input connector 

Pin Details 

J6  (B+) DC+  24 V input 

J9  (B-) DC-   24 V ground 
 

 

 

 

 

 

 

 

11 12 

11. UVW inverter MOSFET 
12. Anti-reverse connection protection 
13. On-board cooling fan ON/OFF Jumper 

13 
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Table 4 denotes the details of the UART related connector (iMOTIONTM Link connector J2, J1 & J8) 

Table 4 J2- iMOTIONTM link connector 

S. No. Pin Details 

1 TXD1 User UART for Script communication (Same as J8 Pin3) 

2 RXD1 User UART for Script communication (Same as J8 Pin2) 

3 & 6 +3.3 V On board 3.3 V supply 

4 & 5 GND Ground 

7 RXD0 MCE Designer & firmware download  (Same as J1 Pin2) 

8 TXD0 MCE Designer & firmware download  (Same as J1 Pin3) 

 

Table 5 provides the details of the motor UVW output connector 

Table 5 Motor side connector 

S. No. Pin Details 

J10 U Connected to motor phase U 

J11 V Connected to motor phase V 

J12 W Connected to motor phase W 
 

 

Table 6 provides the pin assignments of digital Hall interface connector J5  

Table 6 J5 - HALL connector to motor 

Pin Name Pin name connectors 

1 GND Ground 

2 ----- Reserved for analog Hall input AHall2- 

3 DHAL3 Digital Hall input3    

4 DHAL2 Digital Hall input2    

5 DHAL1 Digital Hall input1     

6 +3.3 V On board 3.3 V supply 

 

Table 7 provides the pin assignments of external Duty & Freq and direction input connector J3  

Table 7 J3 – External PWM command and DIR input 

Pin Name Pin name connectors 

1 GND Ground 

2 DIR External motor direction input 

3 Duty/Freq External PWM speed command input (duty cycle or frequency mode)  

4 +3.3 V On board 3.3 V supply 
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4 Product overview of 2ED2304S06F 

Traditional motor control is between 4 – 20 kHz PWM frequency, while new motor control applications need up 

to 30-50 kHz. Hence, gate drivers will be required with lower level-shift switching losses and lower leakage 
currents to reduce the dissipated power during operation. 

Higher PWM frequency allows users to achieve higher motor control dynamics, and reduce motor size and 

weight, which is especially applicable to hand-held electronic devices.  Higher PWM frequency requires lower 
PWM propagation delay matching time between high-side and low-side MOS drives to reduce the waveform 
distortion. Moreover, higher time accuracy of the motor current sampling also requires gate drivers to deliver 
delay matching as low as possible.   

International Rectifier was the first innovator of junction isolation technology and Infineon is now continuing 
the history of innovation with its unique SOI technology for high voltage. Infineon’s SOI-based level-shift 

technology requires less energy to transfer the control (PWM) signal from the low voltage control side to the 
high-voltage portion of the gate driver (the high voltage well), and provides additional performance and 
reliability with reduced leakage currents and increased latch-up immunity. It also enables higher switching 

frequencies above 100 kHz. Some key parameters of 2ED2304 compared with IRS2304 are shown in Table 8. 

Table 8 IRS2304S Vs. 2ED2304 

Parameter IRS2304S 2ED2304S 

Operating voltage 600 V 650 V 

Input configuration HIN, LIN HIN, LIN 

Bootstrap diode External Integrated 

Negative VS transient [Max] < -50 V <= -100 V 

I
O+

 / 
 
I

O- 
[TYP] 290 mA / 600 mA 360 mA / 700 mA 

Prop. delay - t
ON/OFF  

(ns - Typ) 220 / 200 310 / 300 

Delay matching – MT  (ns – Typ) 46 20 

Dead time – DT (ns)  (Typ) 100 75  

Matching DT (ns - Max) 50 50 

t
r/f

 (ns – Typ) 70 / 35 48 / 24 

Level shift losses - 50% lower 

Logic operation  for Vs of COM -5V ~ +600V -8 V ~ +600 V 
 

 Infineon’s new SOI drivers with increased performance and integration are now being expanded with the 

2ED2304S06F 650 V half-bridge SOI gate driver with integrated bootstrap diode, superior negative VS 
robustness, reduced level-shift losses, and more reliable performance. 

 

2ED2304S06F has successfully operated at 120 kRPM with an iMOTIONTM controller in a battery-powered 
vacuum cleaner application. Other new applications utilizing HB-LLC topology that switch above 100 kHz can 

now be implemented using the 2ED2304S06F. 
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4.1 Internal block diagram  

Figure 4 illustrates the internal block diagram of the 2ED2304S06F. 
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Figure 4 Block diagram of 2ED2304 

The Schmitt trigger logic inputs are compatible with standard CMOS or LSTTL logic down to 3.3 V. The output 

drivers feature a high-pulse current buffer stage designed for minimum driver cross-conduction. The floating 

channel can be used to drive an N-channel power MOSFET or IGBT in the high-side configuration, which 

operates up to 650 V.  

Additionally, the offline clamping function provides an inherent protection of the parasitic turn-on by floating 
gate conditions when the IC is not power-supplied. 

2ED2304S06F is DSO-8 package; the pin definition is the same as IRS2304, as shown in Figure 5. 

                                                                                            

Figure 5 2ED2304S06F lead assignments PG-DSO-8 (top view) 
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4.2 The detailed features and functions of 2ED2304 

 Infineon thin-film-SOI technology, high reliability and lower power loss 

 Fully operational to +650 V 

 Output source/sink current capability +0.36 A/-0.7 A 

 

 Floating channel designed for bootstrap operation 

 Integrated ultra-fast, low RDS(ON) bootstrap diode, reduced PCB and internal logic complexity 

 Tolerant to negative transient voltage up to -100 V (pulse width is up 300 ns) provided by SOI technology 
 

 Internal dead time 75 ns (typical)  and dead time matching time 10 ns (typical) 

 dV/dt immune ±50 V 

 10 ns (typical), 60 ns max. propagation delay matching 

 Gate drive supply range from 10 V to 20 V 
 

 Undervoltage lockout for both channels 

 RoHS compliant 

 3.3 V, 5 V and 15 V input logic compatible 

 

4.3 Tolerant to negative transient voltage on VS pin (-VS) 

A common problem in today’s power switching converters is the transient response of the switch node’s 
voltage, as the power switches transition on and off quickly while carrying a large current, as illustrated in 

Figure 6. 

 
 

Figure 6 Negative VS 

This negative VS voltage can cause the high side output to change state, or the device to latch up resulting in 
large currents or IQCC shifts. A high side output transition from high to low will not damage the IC or the switch, 

Negative VS 
spike 
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however, a high side output transition from low to high when the low side is on can cause switch damage or 
unreliable motor operation. 

Negative VS excursions occur during faster switching events over long PCB traces or wiring harnesses that form 

a parasitic inductor. The higher the parasitic inductor value and switching frequency, the larger is the potential 
negative VS voltage that is developed during a switching event. 

Negative VS immunity is a key determining factor in selecting a robust gate driver IC that will be more immune 

to negative VS excursions due to inductive parasitic on the PCB or wiring harness. 

In a typical motor drive system, dV/dt is typically designed to be in the range of 3-5 V/ns. The negative transient 

voltage can exceed this range during some events such as short-circuit and overcurrent shutdown, when di/dt is 

greater than in normal operation. 

2ED2304S06F has been designed for the robustness required in many of today’s demanding applications. An 
indication of the robustness of 2ED2304S06F can be seen in Figure 7, where the 2ED2304S06F safe operating area 
(SOA) is shown at VBS=15 V based on repetitive negative transient voltage spikes. A negative transient voltage 
falling in the gray area (outside SOA) may lead to IC permanent damage; and vice versa, unwanted functional 

anomalies or permanent damage to the IC do not appear if negative VS transients fall within the SOA.  

 

Figure 7 Negative transient voltage SOA on VS pin for 2ED2304S06F @ VBS=15 V 

Even though the 2ED2304S06F has been shown to be able to handle these large, negative transient voltage 
conditions, it is highly recommended that the circuit designer always limit the negative transient voltage on the 
VS pin as much as possible by careful PCB layout and component use. 
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5 Getting started with REF- Vacuum -C101-2ED 

The REF-VACUUM-C101-2ED reference designs are shipped with embedded firmware and default parameters.  

The following steps have to be performed in order to achieve a usable motor controller IC from a blank IMC101T: 

 Programming of the motion control engine (MCE) 

 Programming of parameter sets for system and motor 

 Programming of any customer scripts (optional) 

 Programming of the combined file for an integrated system (optional)  

The iMOTION™ software tools, MCEDesigner and MCEWizard, are required to initially set up the system, as well 

as to control and fine-tune the system performance to match the user’s exact needs. These tools are available 

for download via the Infineon website ( https://www.infineon.com/cms/cn/product/power/motor-control-
ics/digital-motor-controller-imotion/imc101t-t038/#!tools ). Please visit this page periodically to check for 
tool/software updates. 

iMOTIONTM Link or third party isolated USB-to-UART cable is needed to bridge the PC/debugger side and motor 
drive system (the target iMOTION™ device, hot side) with 1 kV DC galvanic isolation.   

This chapter provides more details on setting up the system and getting started with the iMOTION™ development 
platform. 

After downloading and installing the iMOTION™ PC tools, MCEWizard and MCEDesigner, the following steps need 

to be executed in order to run the motor. Refer to MCEWizard and MCEDesigner documentation for more 
information. 

Figure 8 shows the basic system connection using REF-Vacuum-C101-2ED to run a vacuum motor with 
sensorless mode: 

  

Figure 8 System connection example  
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Figure 9 MCEWizard welcome page and MCEDesigner  
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Here are the steps needed to run the motor: 

1. Connect iMOTIONTM Link’s 8-pin cable to J2 with default pin order, and connect PC-USB connector 
iMOTIONTM Link. (Or connect third party isolated USB-to-UART cable to J1). 

2. Use MCEWizard to enter the target motor’s system and operating parameters, as well as evaluation board’s 
hardware parameters, which will then be used to calculate the digital parameter set of the controller 
representing the complete motor drive system.  

3. After system and operating parameters are set, go to the “Verify & Save Page” and click on “Calculate” button. 
If no errors are reported, then save the drive parameter set into your project directory by clicking “Export to 

Designer file (.txt)” ( Figure 10); if an error is detected, double-click on the error message (highlighted in RED) 

and adjust the related parameter. Saved drive system parameter file will be later used by the MCEDesigner in 
step 9.  

(Please refer to MCEWizard_V2.3.0.0 User Guide.pdf for more details, which is in MCE Wizard’s install path) 

 

Figure 10 MCEWizard Verify and Save page 

4. Connect 24 V power supply and UVW outputs to the motor. 

5. Turn on 24 V power supply or connect 6S ~ 7S Li battery, green LED1 ON. 

6. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC101T device 
(IMC101T_Vxxx.irc) by clicking “File” > “Open”.   

(IMC101T_Vxxx.irc file is included in downloaded “IMC101T MCE Software Package”) 

7. MCEDesigner should automatically connect to the REF-VACUUM-C101-2ED board using default COM port 
(Indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it cannot 
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establish the connection due to incorrect COM port, change COM port by doing the following steps: click on 
the “System Page” window and then click on “Preferences > Connection > Connect using”, and choose one of 
the other available COM ports from the drop-down list. 

 

8. In case of blank IC:  If the firmware has been erased from the IMC101T, a warning message will pop up saying 
“Target device firmware and parameters file are not programmed! Please program firmware and parameters 

file” (Figure 11).  See step 9 on how to obtain/program firmware and parameters.  

 

Figure 11 MCEDesigner warning message 

9. In case of blank IC:  Use the following steps to program the firmware and the parameters file into the internal 

Flash memory of iMOTION™ Control IC: Click on system page, click “Tools” > “Programmer” and select 
“Program Firmware and Parameters,” shown as Figure 12 below.  The encrypted firmware is available in 

“IMC101T MCE Software Package,” regarding the parameters file, browse and select the .txt file in step 3. 

 

(If blank IMC101T IC, MCE Designer will pop up information “Target device firmware and parameter files are not 

programmed!”)  Program the MCE firmware and system parameters into the internal Flash memory of iMOTION™ IC by 

clicking “Tools > Programmer “in the pull-down menu, and then clicking on the “Program Firmware and Parameter” 

check box. Select right Parameter file and firmware file. Finally click “Start” button to program firmware and parameter.  

Then click YES and then OK button about 20 seconds later; finally “Save As” the IRC file to your own file name that contains 

COM config, Parameters & firmware file path information.  (Please refer to MCEDesigner User Guide.pdf and 

MCEDesigner_V2.3.0.0 Application Guide.pdf for more details, which is in MCE Designer’s install path) 

 

Red LED2 will flash on after the program is done. 

 
Figure 12 MCEDesigner warning message 
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10. Double click “VF Diagnostic” function in motor1 page, monitor motor current with oscilloscope. If motor 
current is not sinusoidal, change target speed and Vd_Ext in VF Diagnostic sub-function, then double-click 
“VF Diagnostic” until oscilloscope shows a steady sinusoidal current, with amplitude of 30~50% motor rate 
current. 

Double-click “Iu & Iv_Slow” in System page > Monitor Definitions, the motor current feedback would be very 

clean and sinusoidal, as shown in Figure 13, otherwise please tune “Gating Propagation Delay & Phase Shift 
Window Size” in MCE Wizard. The sampled motor current amplitude should be over 300 cts ~500 cts 
(corresponding to 30%~50% motor rate current); otherwise, motor current sample related hardware and 

setup need tuning. 

“VF Diagnostic” sub function can verify: 

• If motor is correctly connected  

• If MOS & gate driver work as expected 

• If current sensing related parameters are correctly configured 

• If  PCB layout and DC bus decouple have been done correctly 

After “VF Diagnostic” is done, click STOP button (the red traffic light button) to stop PWM. 

 
Figure 13 Trace waveform for Iu & Iv open loop diagnostic 

11.  Start the motor by clicking the green traffic light button in the control bar (or double-click Start Motor sub 
function in Motor1 page, group of User Application Function Definitions); motor runs if above step goes well. 

12. Check motor spin direction, adjust UVW connection order or set negative target speed in MCE Designer if 
direction is wrong. 

13. Set target speed to about 50% of MAX speed, start “Iu & Flx_M” trace with “Auto Repeat On Level,” see 

Figure 14. Flx_M is better within the range of 2000~2500 (rated value is 2048), and MUST be steady and DC-
like.  

Some key tips for better motor-performance tuning: 

• If Flx_M is not steady (swinging or oscillating), double-check motor parameters, speed loop PI gain, flux Estimator 

time constant and PLL PI bandwidth (parameters PLLKp & PLLKi) related setup. 

• If Flx_M is very noisy, double-check current feedback and Vdc-related hardware and parameters. 

• If Flx_M is far from 2048, “Motor Back EMF Constant (Ke)” needs to be adjusted in MCE Wizard. 
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Figure 14 Trace waveform for Iu & Flx-M at 50% speed 

 

14. Once the firmware has been programmed, in case a new parameters’ file has to be programmed, follow the 

same instructions given in step 9. In this case, firmware programming is no longer needed and it is possible 

to select the first option “Program Parameters.” 

 

Note: For detailed information on controller programming, refer to AN2018-33 iMOTION™ 2.0 Device Programming, 
MCEDesigner documentation and MCEWizard documentation. 
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6 Hardware description of REF-Vacuum-C101-2ED 

The REF-Vacuum-C101-2ED board is an optimized design for 6S ~ 7S Li battery power vacuum applications, 

which can be used for different voltages (outside the range of 18 V~30 V) or different power classes (well below 
600 W), by replacing different MOS, current-sensing resistors and by modifying auxiliary power supply. To meet 

individual customer requirements and to make the REF-Vacuum-C101-2ED reference design a basis for 
development or modification, all necessary technical data like schematics, layout and components are 
included in this chapter. 

6.1 Inverter section  

The inverter section is implemented using 2ED2304S06F plus BSC030N04NS as sketched in Figure 15.  

2ED2304S06F driver ability is source current +0.36 A and sink current -0.7 A; R7 & R11 is the gate resistor to 
control the U-phase MOSFET’s ON time, and R9 & R13 together with R7 & R11 to set the OFF time. 

 

Figure 15 Inverter section on REF-Vacuum-C101-2ED 

The recommended dead time is 200~400 ns for MCEWizard setup, which represents a real ON/OFF time of 

150~200 ns, as shown in  Figure 16 and Figure 17. 

Note: The gate resistors and dead time setup need adjusting if new MOSFETs are used, since different MOS have 
different Qg. 
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Figure 16 ON-time test waveform 

 
 

Figure 17 OFF-time test waveform 
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6.1.1 DC bus sensing and MCEWizard configuration 

Figure 18 provides the DC bus sense resistor details on the REF-Vacuum-C101-2ED reference design.  

The high-side resistor is 100 kOhm and the low-side resistor is 10 kΩ; 0 ~ 36.3 V DCBUS reflecting 0 ~ 3.3 V at the 
ADC input pin with 3.3 V power supply, and 0~55 V for 5 V power supply (by replacing U2 to 5V LDO).  
 

 

Figure 18 DC bus sense resistor on REF-Vacuum-C101-2ED reference design 

For a wider DC sensing range, R12 can be adjusted to a higher value; the hardware changes should be 
configured in MCEWizard, as shown in Figure 19.  

 

Figure 19 DC bus sensing configuration in MCEWizard 

The Vdc sensing low-pass filter time constant is (R12//R15)*C17 = (100 k//10 k)*10 nF = 91 us, which is at least 
two times the 22 kHz PWM periods (45 us); C17 can be adjusted to higher capacitance for clean Vdc sensing, if 
new motor and new MOSFET cause Vdc bus sensing noise at MCEDesigner trace. 
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6.1.2 External op-amp configuration and calculation for current feedback  

The current input scaling value is the product of the shunt resistance in milliohms and gain of external current 
sense amplifier for the REF-Vacuum-C101-2ED reference design, as shown in Figure 20.  
 

 

Figure 20 Current feedback scaling outside IMC101T 

A 2 mOhm 3 W 2512 package shunt resistor and 10X external-gain operational amplifier (op-amp) is the default 
configuration for the REF-Vacuum-C101-2ED reference design, which means 1 A DC bus current produces 20 mV 
voltage to ADC input, MCEWizard’ s “Motor1 Current Input Scaling” needs input of 20 mV/A. 

Please note that the Internal Current Feedback Amplifier Gain (Question 84 for MCEWizard V2.3.0.0) is ADC’s 

internal gain, which defines the maximum ADC input range to VCC/Gain. For 3.3 V power supply, the ADC sensing 
range is 0~1.1 V if 3X internal gain is selected, and 0~550 mV if 6X internal gain is selected, 0~275 mV if 12X 

internal gain is selected. 

 

Figure 21 Current feedback with external op-amp 

 Figure 21 shows the external amplifier gain circuit in REF-Vacuum-C101-2ED reference design, which is a typical 
differential amplifier, with input low pass filter and operational bias. C4, R30, R31 R10, R18 build the input 

differential mode LPF, which can damping parts of PWM switching noise. The default LPF time constants is 
2*RC = 2*(R31//R10)*C4 = 100 ns, which corresponds to DC bus current ring time. The typical setup time is 
0.1~0.5 us, which depends on PCB layout, DC bus decouple capacitor and MOS gate driver configuration. 

For better common-mode, noise-rejection ability, a balanced differential amplifier is highly recommended, 

which means R19 is equal to the value of R6 & R8 in parallel.  

The divider of R6 & R8 provide operational bias for the amplifier, which affects the maximum motoring current 

and regeneration current range. With the default configuration of REF-Vacuum-C101-2ED, R6=22 k & R8=220 k, 
the op-amp operational bias is 3300 mV * 22 / (22+220) = 300 mV, which means: 

- Op-amp outputs 300 mV at zero motor current (motor stopped) 
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- Negative current range sensing range is 300 mV/op-amp gain/RS1, corresponding to regeneration current 
limit in MCEWizard (parameters of RegenLim) 

- If 3X ADC internal gain is selected, there is 800 mV range for motoring condition current sensing (3300 

mV/3 – 300 mV = 800 mV, and 800 mV/op-amp gain/RS1 is the maximum allowable motor current. 
“Motoring current limit * Motor Rated Amps * 1.414” should be below this maximum allowable range, 

which is related to input parameters in MCEWizard. 

- If 1X ADC internal gain is selected, 3000 mV range for motoring mode current sensing (3300 mV – 300 mV = 

3000 mV). 

For a better system signal-to-noise ratio (SNR), 6X and 12X internal AD gain is not recommended when there is 

an external amplifier.  And even for direct AD sensing mode (without external op-amp), whether 12X/6X internal 

gain is acceptable or not depends on the ground noise level, or the final motor control performance. 

 

Figure 22 Current feedback configuration in MCEWizard for REF- Vacuum -C101-2ED 

6.1.3 Configuration and calculation for direct current sensing  

 

For applications that require minimal hardware costs, direct AD samples can be used, which means, without 
external op-amp, and only RC for operational bias and low pass filter, as shown in Figure 23. 

Based on the principle of Kirchhoff's voltage law, the real AD input voltage is decided by the divider of R29 & 
R34: 
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𝐴𝐷 𝑖𝑛𝑝𝑢𝑡 =
𝑅29

𝑅29 + 𝑅34
𝑅𝑆1 ∗ 𝐼𝑏𝑢𝑠 =

5.1𝐾

5.1𝐾 + 0.1𝐾
𝑅𝑆1 ∗ 𝐼𝑏𝑢𝑠 = 0.98 ∗ 𝑅𝑆1 ∗ 𝐼𝑏𝑢𝑠 

 

Figure 23 Current feedback without external op-amp 

R29 & R34 also determine the ADC operational bias for current sensing, which corresponds to the motor 
regeneration operation range. For those applications that only work in motoring mode, the bias can be as low 

as possible to reserve enough ADC range for motoring mode, since negative input would not occur. 

 

Please note that in direct AD sample mode (without external op-amp): 

 The external RC network’s input gain is less than 1. Normally ADC internal gain needs to be configured to 

X3, X6 or X12 to lower the required input signal range and reduce shunt resistor power dissipation.  RS1 

must be much higher than 2 mOhm to achieve enough current sensing signal-to-noise ratio (SNR) and 

improve control performance: For example, to achieve sufficiently high SNR, motor current sensing counts 
need be over 30~50% of AD range (traced Iu peak over 600 cts~1000 cts) at rate motor current, and PCB 
ground noise lower than 5% of total sampled signal in MCEDesigner trace result. 

 There is NO common mode noise rejection ability, compared to external op-amp sample mode. Directly AD 
current sensing mode needs to deal with PCB GND network very carefully to reduce grounding noise as low 

as possible. Please note that any voltage difference between IMC101T’s ADC ground and shunt resistor 
ground will be considered as an “input signal” and deteriorate control performance or increase motor 

audible noise. 

   

For the power rating of the shunt resistor, the following list should be considered: 

 Maximum input current of inverter (IbusRMS) 

 Maximum motor current output (ImotorRMS) 

 Shunt resistor value at Tc = 25C (RSH) 

 Power derating ratio of shunt resistor at TSH=100C according to the manufacturer’s datasheet 

 Safety margin and measure margin  (total 50%~60% derating) 

 Power supply for IMC101T (3.3 V or 5 V) 

An example for shunt resistor and ADC internal gain selection: 
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- Maximum DCBUS input current of inverter (Irms) is 3 A, and already includes 20~30% overload margin 

- Shunt resistor rate power is 1 W  (low cost of thin film 2512 package), 60% derating (allow maximum 0.6 W) 

The shunt resistor power rating is calculated by the following equation. 

𝑃𝑆𝐻 =
𝐼𝑟𝑚𝑠

2 ×𝑅𝑆𝐻

𝑑𝑒𝑟𝑎𝑡𝑖𝑛𝑔 𝑟𝑎𝑡𝑖𝑜
   = 0.6 W =       𝐼𝑟𝑚𝑠

2 × 𝑅𝑆𝐻       ==> 𝑅𝑆𝐻 = 0.066 𝑂ℎ𝑚 = 66 𝑚𝑂ℎ𝑚 

75 mΩ or 50 mΩ can be considered, supposing maximum input current occurs at maximum PWM modulation 

rate, according to the conservation of power: 

𝑃𝑜𝑤𝑒𝑟 𝑖𝑛𝑝𝑢𝑡 = 𝑉𝑑𝑐 ∗ 𝐼𝑏𝑢𝑠𝑅𝑀𝑆 = 3 ∗
𝑉𝑑𝑐

1.414
∗ 𝐼𝑚𝑜𝑡𝑜𝑟𝑅𝑀𝑆 

𝐼𝑚𝑜𝑡𝑜𝑟𝑅𝑀𝑆 = 0.47 ∗ 𝐼𝑏𝑢𝑠𝑅𝑀𝑆 

Maximum voltage to ADC pin:  3A *0.47* 1.414 * 50 Ohm = 99.7 mV, which is about 1/33 of 3300 mV. 

ADC internal gain can be 12X, whose maximum input range is 3300 mV/12 = 275 mV, consider equaled MotorLim 

and RegenLim, the maximum motoring and regenerating sensing range is 275/2 = 137.5 mV   > 99.7 mV. 

Measure margin check: 50 mΩ shunt resistor has a margin of (137.5-99.7)/99.7 = 37.9%  

Next, checking the real derating of 50 mΩ and 75 mΩ shunt resistors:   

𝐷𝑒𝑟𝑎𝑡𝑖𝑛𝑔 𝑓𝑜𝑟 50mΩ =
𝐼𝑟𝑚𝑠

2 × 𝑅𝑆𝐻

𝑅𝑎𝑡𝑒 𝑝𝑜𝑤𝑒𝑟
=  

3𝐴 ∗ 3𝐴 × 50𝑚Ω

1𝑊
= 0.45 

𝐷𝑒𝑟𝑎𝑡𝑖𝑛𝑔 𝑓𝑜𝑟 75mΩ =
𝐼𝑟𝑚𝑠

2 × 𝑅𝑆𝐻

𝑅𝑎𝑡𝑒 𝑝𝑜𝑤𝑒𝑟
=  

3𝐴 ∗ 3𝐴 × 75𝑚Ω

1𝑊
= 0.675 

The 50 mΩ shunt resistor has a higher power margin, and 75 mΩ has better SNR.  Since the power derating is 

highly related to the real thermal resistance of the PCB, we can test both 50 mΩ and 75 mΩ shunt resistors and 

decide which one is better on the tradeoff of SNR and real temperature rising. 

 

6.1.4 Inverter overcurrent protection and motor gatekill configuration 

Figure 24 displays the overcurrent protection circuit for the IMC101T application. R29 & R34 sensed voltage (or 

external op-amp) is connected to ADC and internal comparators to achieve the overcurrent protection function. 
Only internal comparators are used for overcurrent protection.  

The reference of the internal comparators is set by IMC101T’s internal DAC, and external C31 is the low pass 
filter capacitor. MCEWizard calculate the DAC reference voltage based on the question input of “Device 

Overcurrent trigger level setting for Comparator” and “Motor1 Current Input to ADC Offset Voltage”. MCEWizard 
output parameter CompRef define the DAC output voltage, which depends on the 3 items listed below and 

shown in Figure 24 & 25 

A: Expected OC threshold 

B: Gain of external current sensing network 
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C: Offset of the external op-amp or RC divider 
 

 

Figure 24 Overcurrent protection circuit on the REF-Vacuum-C101-2ED reference design 

 



  

 

User Guide                 www.Infineon.com/iMotion  30 of 43 www.Infineon.com/SOI                                Revision 1.0 

  2020-5-22 

 

UG2020-11 REF-Vacuum-C101-2ED User Guide  

 

Figure 25 Overcurrent protection setup in MCEWizard 

Normally it is recommended to set a value higher than motor maximum peak current (maximum RMS current * 

1.414)  in “Device Overcurrent trigger level setting for Comparator”, with a reserve of at least 30% margin, 
especially for ultra-low impedance  motors, of which peak saw tooth current would trigger unwanted 

overcurrent fault. 

 

6.2 NTC thermistor characteristics and overheat protection calculation 

IMC101T’s firmware has overheat protection, Pin7 is the dedicated input of NTC temperature sensing. An 
external NTC thermistor is attached on the copper near Q7 & RS1, where is the hottest point on the board. 

To activate over-temperature protection, 2 setups in MCEWizard as shown in Figure 26 & Figure 28 are needed:  

- Enable over-temperature shutdown function 

- Set voltage for shutdown, consider the temperature difference between MOS and NTC 
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Figure 26 Over-temperature protection enabled in MCEWizard 

6.2.1 External NTC thermistor characteristics 

The NXFT5WF104 thermistor’s B-constant is 4250, typical resistance and output of temperature-sensing voltage 
listed in Table 9.  

Table 9 NTC – Thermistor Characteristics 

Temperature 

(℃) 

Resistance 

(kOhm) 

Vout 

(mV) 

25 100 3000  

50 33.195 2536  

60 22.224 2276  

70 15.184 1990  

80 10.566 1695  

90 7.481 1412  

100 5.384 1155  

110 3.934 932  

120 2.916 745  

 B(25/100) 4250 
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The pull-up resistor is 10 k, and IMC101T’s temperature-related AD input voltage is shown in Figure 27. 

  

Figure 27 NTC circuit and output voltage curve 

External NTC temperature shutdown value can be calculated as shown below and configured in MCEWizard as 
shown in Figure 28.  MCEWizard default setup is 1.1 V, which sets the shutdown temperature to about 100°C. 

 

Figure 28 NTC shutdown temperature setup in MCEWizard 
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6.3 Auxiliary power supply 

Figure 29 depicts the schematic of the auxiliary power supply for the REF-Vacuum-C101-2ED board. Two linear 
LDO used for 12 V and 3.3 V power supply. U2 can be replaced by 5 V LDO or adjustable IFX1117ME V to achieve 

higher power supply, for the application that needs higher SNR of motor current sample with external OPA. 

Please note that the undervoltage level of 2ED2304S06F is 8.3~9.1 V, if the DC input is out of the 18 V~30 V 

range; the output voltage of 78M12 needs to be double-checked to make sure 2ED2304S06F can respond to 
PWM command correctly. 

ZD2 &ZD3 are used to reduce power consumption on 78M12. For higher DC voltage input, higher-voltage Zener 
diodes might be needed to make sure 78M12 will not over-heat. And for 12 V or 3S~4S Li battery applications, 
please short ZD2 &ZD3, or bypass U1 directly. 

Both 12 V and 3.3 V power supplies can output 100 mA to external circuit, with on-board cooling fan ON (default 
configuration). If cooling fan is OFF or removed, the maximum output ability is in sum 100 mA, depending on 

the temperature of ZD2 & ZD3 & U1. 
 

 

Figure 29 Power supply section of the REF-Vacuum-C101-2ED reference design 

 

6.4 Schematics for REF-Vacuum-C101-2ED 

The overall schematic diagram for REF-Vacuum-C101-2ED is provided in Figure 30. 
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Figure 30 Schematics for REF-Vacuum-C101-2ED 
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6.5 PCB Layout for REF-Vacuum-C101-2ED 

This board has two electrical layers with 35 µm copper (standard) and dimensions of 115 mm × 60 mm.  For 
applications that do not require cooling fans, the size can be 63.5mm x 60mm if the right-hand section of the 

PCB is removed. The thickness of the PCB board is 1.6 mm. Contact our technical support team for more 
detailed information and the latest Gerber files. 

Figure 31  illustrates the top assembly print of the reference design. 
 

 

Figure 31 Top assembly print of the REF-Vacuum-C101-2ED reference design 
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Figure 32  depicts the bottom assembly print of the reference design. 
 

 

Figure 32 Bottom assembly print of the REF-Vacuum-C101-2ED reference design 

The top layer routing of the PCB is provided in Figure 33 . 
 

 

Figure 33 Top layer routing of the REF-Vacuum-C101-2ED  
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Figure 34  illustrates the bottom layer routing of the PCB. 
 

 

Figure 34 Bottom layer routing of the REF-Vacuum-C101-2ED 
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7 Thermal characterization 

Figure 35 shows the thermal characterizations of REF-Vacuum-C101-2ED, based on 2 layers of FR4 PCB, as shown 

in Figures 31~34.  

The tests reported were performed under the following conditions: tamb=25°C, Vdc = 24 V, different phase current 

values until the MOS case reaches 105 °C, four PWM frequencies (22, 45, 65 and 80 kHz) tested, 3-phase 
modulation mode only, since switching loss is no longer a major issue for low voltage motor drive application 
and 2-phase modulation is normally not needed.  

 

Figure 35 REF-Vacuum-C101-2ED thermal characterization, tamb=25°C, different phase current values until 

the case reaches 105°C   
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8 Bill of material 

Table 10 provides the complete bill of materials for the REF-Vacuum-C101-2ED. 

Table 10 Bill of materials 

No. Qty Part description Designator Part number Manufacturer 

1 
5 CAP CER 10μF 25V X5R 0805 

C1, C8, C11, C38, 
C40 CC0805KKX5R8BB106   

2 
8 CAP CER 4.7μF 50V X5R 0805 

C2, C3, C5, C9, C14, 
C24, C33, C43 CC0805KKX5R9BB475  

3 3 CAP CER 100pF 25V X5R 0603 C4, C37, C42 CC0201KRX5R8BB101  

4 
2 

CAP ALUM 470uF 35V, Low 
impedance  C6, C7 860080575017 

Wurth 
Elektronik 

5 

14 CAP CER 1μF 25V X5R 0603 

C10, C12, C13, C15, 
C16, C18, C19, C20, 
C25, C26, C27, C30, 
C32, C41 CC0603KRX5R8BB105  

6 
5 CAP CER 10nF 25V X5R 0603 

C17, C22, C23, C28, 
C31 CC0201KRX5R8BB103  

7 
1 

CAP CER 1μF 10% 50V X5R 
0805 C21 CC0805KKX5R9BB105  

8 4 CAP CER 4.7nF 25V X5R 0603 C34, C35, C36, C39 CC0201KRX5R8BB472  

9 
6 1N4148 Diode 

D1, D2, D3, D4, D5, 
D6 1N4148  

10 
3 

4Pin 1.25mm Male Vertical 
Shrouded Header J1, J3, J8 653004114822 

Wurth 
Elektronik 

11 
1 

iMOTIONTM_LINK Connector, 
CON4*2  J2   

 Wurth 
Elektronik 

12 
1  3-Pin, 2.54mm for jumper J4  Jumper 

 Wurth 
Elektronik 

13 
1 

 HALL Connector, 6-Pin 2.54mm 
Header J5 691210910006 

Wurth 
Elektronik 

14 
2 

DC input  Connector, M4, 
6x6x7.5mm, J6, J9 

M4-6x6x7.5mm 
Connector  

15 
3 Motor Connector, M3, 5x5x6mm J10, J11, J12 

M3-5x5x6mm 
Connector  

16 
2 GREEN LED 0603 LED1, LED3   

 Wurth 
Elektronik 

17 
1 REDLED 0603 LED2   

 Wurth 
Elektronik 

18 
1 

NTC, 100 kOhm, thermal 
resistor NTC1 B57371V2104+06  

19 
7 3mOhm 40V NMOS 

Q1, Q2, Q3, Q4, Q5, 
Q6, Q7 BSC030N04NS G Infineon 

20 
2 

RES SMD 10 kOhm 5% 1/10W 
0603 R5, R16 AR0603JR-0710KL  

21 
1 

RES SMD 22 kOhm 1% 1/10W 
0603 R6 AR0603FR-0722KL  

22 
6 

RES SMD 47 Ohm 5% 1/10W 
0603 

R7, R11, R21, R25, 
R33, R37 AR0603JR-0747RL  
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No. Qty Part description Designator Part number Manufacturer 

23 
1 

RES SMD 220 kOhm 1% 1/10W 
0603 R8 AR0603FR-07220KL  

24 6 
RES SMD 15 Ohm 5% 1/10W 
0603 

R9, R13, R23, R27, 
R36, R38 AR0603JR-0715RL  

25 
4 

RES SMD 1 kOhm 1% 1/10W 
0603 R10, R18, R30, R31 AR0603FR-071 L  

26 
1 

RES SMD 100 kOhm 1% 1/8W 
0805 R12 AR0805FR-07100KL  

27 
1 

RES SMD 10 kOhm 1% 1/10W 
0603 R15 AR0603FR-0710KL  

28 
8 

RES SMD 2 kOhm 5% 1/10W 
0603 

R17, R22, R35, R39, 
R41, R42,  
R43, R44 AR0603JR-072KL  

29 
1 

RES SMD 20 kOhm 1% 1/10W 
0603 R19 AR0603FR-0720KL  

30 
2 

RES SMD 100 Ohm 5% 1/10W 
0603 R20, R24 AR0603JR-07100RL  

31 
1 

RES SMD 0 Ohm 5% 1/10W 
0603 R32 AR0603JR-070RL  

32 
1 

2 mOhm, 3W 2512 Shunt 
Resistor RS1 BVT-I-R002 Isabellen 

33 1 78M12, 12V Voltage Regulator U1 L78M12CDT-TR  

34 1 3.3V 1A Voltage Regulator U2 IFX1117ME V33 Infineon 

35 
3 

2ED2304, 0.36A/0.7A/650V 
Gate Driver U3, U4, U5 2ED2304S06F Infineon 

36 
1 

IMC101T-T038, iMOTIONTM2 
controller U6 IMC101T-T038 Infineon 

37 
1 

SGM721XN5, 11 MHz, 8.5V/us, 
CMOS OPA U7 SGM721XN5/TR SG Micro 

38 
1 

10 kOhm 15mm linear 
Potentiometer W1 RK09K113   

39 
1 

12V/0.5W, Surface mount Zener 
diode ZD1 BZT52C12  

40 2 1N4730A, 3.9V/1W Zener diode ZD2, ZD3 1N4730A  

41 1  24V 0.15A cooling Fan   CJY5015  
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9 Reference 

[1] Datasheet of Infineon 2ED2304S06F 

[2] Datasheet of Infineon IMC101T 

[3] MCEWizard User Guide 

[4] MCEDesigner User Guide 

[5]   Infineon-MCESW-RM-User Manual 

 

Note: All listed reference materials are available for download on Infineon’s website 
www.infineon.com/.  

Note: All iMOTIONTM MADK reference design’s user manuals are available at www.infineon.com/MADK  

Note: All the datasheets and documents for OptiMOSTM are available at www.infineon.com/OptiMos. 

All the iMOTIONTM IC’s Datasheets and documents are available at www.Infineon.com/iMotion 
All the Datasheets and documents for SOI gate drivers are available at www.Infineon.com/SOI 
 

 

 

Attention: Infineon’s product registration is now done online. You can register your board and download 
further information. 

There are three easy steps to register: 

1. Go to www.Infineon.com/ login to myinfineon 

2. Click on “Product Registration” 

3. Choose your board and enter board series number;  download the related information package 
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